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C H A P T E R  1
Get started with Cisco UC Integration for
Microsoft Lync

• Cisco UC Integration for Microsoft Lync, page 1

• Docked Window, page 2

• Incoming Call Window, page 2

• Call Window, page 3

• Hub Window, page 4

• Options Window, page 5

Cisco UC Integration for Microsoft Lync
Cisco UC Integration for Microsoft Lync is a Microsoft Windows desktop application that provides access
to Cisco Unified Communications from Microsoft Lync. The solution extends the presence and instant
messaging capabilities of Microsoft Lync by providing access to a broad set of Cisco Unified Communications
capabilities; including software phone standards-based video, unified messaging, conferencing, desktop phone
control and phone presence.

Key features of Cisco UC Integration for Microsoft Lync include:

• Make and receive video calls using the Cisco Precision Video engine.

• Make and receive phone calls through Cisco Unified Communications Manager.

• Drag and drop and right-click integration with the Microsoft Lync contact list.

• Instant Messaging and Presence integration with Microsoft Lync.

• Mute, hold, and transfer during calls.

• Software phone or desktop phone mode selection.

• Communications history of missed, placed, and received calls.

• Audio and visual notification of incoming calls.

• Ad hoc conferencing.
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• Visual voicemail.

• Click to Call from Internet Explorer, Microsoft Outlook and other Microsoft Office applications.

Docked Window
Cisco UC Integration for Microsoft Lync now includes a user interface option that displays a small window
at the top of the screen and allows users to quickly access common functions.

Select View > Show docked window to show or hide the docked window.

Select View > Position docked window to position the docked window and then select one of the following:

• Top left

• Top center

• Top right

The docked window provides access to the following functions:

• Contact search

• Direct dialing of phone numbers

• Call history

• Voicemail

• Hub display

Users must not position the Microsoft Windows taskbar on the top of the screen. The docked window
displays only at the top of the screen. If users position the Windows taskbar at the top of the screen, the
taskbar might overlay the docked window. If the taskbar overlays the docked window, the users cannot
access the docked window.

Restriction

Incoming Call Window
The Incoming Call window displays when you receive an incoming call. This window provides options for:

• Accepting a call
Select Accept to connect the call and begin a conversation. The Call window is displayed after the call
is connected. See Call Window, on page 3 for more information.

• Declining a call
Select Decline to not answer the call. Declined calls are sent to voicemail if it is configured. See
Voicemail, on page 11 for more information.
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Call Window
The Call window is displayed during every connected call. This window provides options for control of the
call and displays video during video calls. See Options Window, on page 5 for information on how to
control how video is displayed when a call is connected.

The Call window provides the following call controls:

• Start my video
Starts sending video in calls where video is not automatically sent.

• Full screen
Expands video display to a full screen view.

• Toggle self-view
Opens a small video display that shows the video you are sending.

• Keypad
Opens a keypad to enter digits.

•Mute

• Mutes the audio.

• Hold
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Places the current call on hold.

• Transfer
Provides options to transfer the call to a different number.

•Merge

Provides options to merge the current call with another.

• Conference Call
Provides options for creating a conference call.

Hub Window
The Hub window displays call history and voicemails. Phone configuration is also performed on this window.
The Hub window is displayed when the user first logs into the application but can be hidden by closing it.
Use the Docked window when the Hub window is closed to access the Hub window functions. See Docked
Window, on page 2 for more information.
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Options Window
TheOptions window is used to configure CiscoUC Integration forMicrosoft Lync according to user preferences
and deployment. Access the window by selecting File > Options on the Hub window. Select Apply or OK
after making changes on this window to save those changes. Select Cancel to cancel any changes.

The following table lists the settings that can be configured on this window.

DescriptionSettingCategory

Starts the application
automatically when the
computer is started if
selected.

Start Cisco UC for Lync
when my computer
starts.

General

User Guide for Cisco UC Integration for Microsoft Lync and Cisco Virtualization Experience Media Engine for SUSE
Linux Release 9.7    

5

Get started with Cisco UC Integration for Microsoft Lync
Options Window



DescriptionSettingCategory

Automatically sends
video when a calls starts
if selected. This is the
default selection.

Always start calls with
video.

Calls

Never sends video when
a call starts if selected.
Video can be started
manually during the call.

Never start calls with
video.

Select the speaker the
application will use from
the drop down list. Use
the slider under the drop
down list to adjust the
volume.

SpeakerAudio

Select the microphone the
application will use from
the drop down list. Use
the slider under the drop
down list to adjust the
volume. The strength
indicator under the drop
down list indicates the
current loudness of the
microphone.

Microphone

Select the device the
application will use to
play ringer and alert
sounds from the drop
down list. Use the slider
under the drop down list
to adjust the volume.

Ringer/Alerts

Select Advanced >> to
arrange the order of
preference for each audio
device.

Advanced >>

Select the camera the
application will use from
the drop down list. A
video preview will be
displayed if the camera is
selected successfully.

CameraVideo

Select Advanced >> to
arrange the order of
preference for each
camera device.

Advanced >>
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DescriptionSettingCategory

Enter the user name and
password associated with
your Cisco Unity
Connection voicemail
account. Consult your
system administrator if
you do not have this
information.
Select Advanced >> if
you need to input Cisco
Unity Connection server
information. This
information will be
supplied by your system
administrator if necessary.

VoicemailPhone accounts
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C H A P T E R  2
Features and Functionality

• Contact Search, page 9

• Call History, page 10

• Direct Dial, page 10

• Drag and Drop Contacts, page 10

• Call a Contact From Microsoft Lync, page 11

• Receive a Call, page 11

• Voicemail, page 11

• Click to Call Functionality, page 12

• Set the Preferred Phone Device, page 13

• Call Information Windows, page 13

• Initiate a Chat Session, page 13

Contact Search
Perform the following procedure to place a call using the contact search.

Procedure

Step 1 Select the dockable window.
Step 2 Begin typing the name of the contact in the search box.
Step 3 Select the desired contact from the search results.
Step 4 Use the call icon beside the contact name to place a call.
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Call History
Perform the following procedure to place a call using the call history.

Procedure

Step 1 Select the dockable window.
Step 2 Select the Calls icon.

The Hub window opens.

Step 3 Select the desired phone number from the list.
Step 4 Use the call icon beside the phone number to place a call.
Step 5 Close the Hub window.

Direct Dial
Perform the following procedure to place a call using direct dialing.

Procedure

Step 1 Select the dockable window.
Step 2 Enter the phone number in the search box.
Step 3 Press Enter.

Drag and Drop Contacts
Perform the following procedure to place a call by dragging and dropping Microsoft Lync contacts.

Procedure

Step 1 Select Microsoft Lync.
Step 2 Select and drag the desired contact to the dockable window.
Step 3 Drop the contact on the dockable window.

A call will be placed to the contact.

Drag and drop is not currently supported with Microsoft Lync
2013.

Note
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Call a Contact From Microsoft Lync
Perform the following procedure to call a contact from within Microsoft Lync.

Procedure

Step 1 Select Microsoft Lync.
Step 2 Perform one of the following actions to place a call:

a) Right-click a contact and select Place Call.
b) Select Show Participant List from aMicrosoft Lync instant messaging window. Right-click a participant

and select Place Call.
c) Select several participants in a Microsoft Lync group chat and right click to make a conference call. This

feature is only available with Microsoft Lync 2010.
d) Right-click a contact and display their Microsoft Lync Contact Card. Select View more options for

interacting with this person. Use the presented option for making a call. This feature is only available
with Microsoft Lync 2010.

Receive a Call
The Incoming Call window displays when you receive an incoming call. This window provides options for:

• Accepting a call
Select Accept to connect the call and begin a conversation. The Call window is displayed after the call
is connected. See Call Window, on page 3 for more information.

• Declining a call
Select Decline to not answer the call. Declined calls are sent to voicemail if it is configured. See
Voicemail, on page 11 for more information.

Voicemail
The Voicemail tab on the Hub window provides access to your voicemail. This tab displays a list of all current
voicemail messages.

Cisco UC Integration with Microsoft Lync provides access to your corporate voicemail. Select the Voicemail
tab on the main window. This tab displays a list of all current voicemail messages. You can interact with the
messages on this tab by:

• Selecting a message to play it.

• Selecting anywhere in the playback bar to reverse or advance playback.

• Pausing playback by selecting the Pause button.

Voicemail messages are deleted by selecting a message, right-clicking it, and selecting Delete.
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The text of unplayed messages are bolded to distinguish them from played messages.

Click to Call Functionality
Cisco UC Integration for Microsoft Lync integrates with Microsoft Outlook, Microsoft Excel, and Microsoft
Internet Explorer to provide Click to Call functionality in those applications. Click to Call provides the ability
to call phone numbers or contacts without leaving the application. The following features are provided:

•Microsoft Outlook

◦Call the sender of the currently highlighted message in the main Outlook window using the button
provided on the Ribbon (Microsoft Outlook 2010 only).

◦Select a recipient of the currently highlighted message to call in the main Outlook window using
the button provided on the Ribbon (Microsoft Outlook 2010 only).

◦Call the sender of the currently read email from the Ribbon in the message window.

◦Select a recipient of the currently read email to call from the Ribbon in the message window.

◦Call the selected contact or recipients list directly or using the Call With Edit option with the
Ribbon button.

◦Right-click the sender or any recipient to call them using theAdditional Actions right-click menu
item. Senders or recipients can be called directly or using the Call With Edit option. This is a
Smart Tag option only available in Microsoft Outlook 2003 or 2007.

◦Right-click any user and call them. Use the Contacts > Additional Actions menu in Microsoft
Office 2007. Contacts are accessed directly in Microsoft Office 2010. Contacts can be called
directly or using the Call With Edit option.

◦Call a contact from the Contact window using the buttons provided on the Ribbon.

◦Call a contact from any Calendar item using the buttons provided on the Ribbon.

•Microsoft Excel

◦Call a phone number highlighted in a spreadsheet using the button provided on the Ribbon.

◦Right-click and call a phone number highlighted in a spreadsheet.

◦Use theCall with Edit button in the Ribbon to modify a selected value or enter a different number.

◦Use the Call with Edit item in the right-click menu to modify a selected value or enter a different
number.

•Microsoft Internet Explorer

◦Right-click and call a phone number highlighted on a web page.

◦Use the Call with Edit item in the right-click menu to modify a selected value or enter a different
number.

See Software Requirements in the Cisco UC Integration for Microsoft Lync Release Notes for information on
the supported versions of each application.
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Set the Preferred Phone Device
Perform the following procedure to set the preferred phone device.

Procedure

Step 1 Select the dockable window.
Step 2 Select the Hub window icon.
Step 3 Select the phone device selection drop down list in the bottom right hand corner of the Hub window.

This list is populated with all of your configured phone devices. If a device is not available and should
be, contact your system administrator.

Note

Step 4 Select your preferred phone device.

Call Information Windows
Cisco UC Integration for Microsoft Lync has the ability to display contact and other information about
connected incoming calls. These information windows are displayed after the call is connected in either a new
Microsoft Internet Explorer tab or window. A new information window is displayed when the following
occurs:

• An incoming call is connected.

• A call is transferred to you from another user.

• Participants are added to a conference call. An informationwindow is displayed for each unique participant
in a conference call.

These information windows are configured by your administrator. They will inform you if this functionality
is available to you.

Initiate a Chat Session
Perform the following procedure to initiate a Microsoft Lync chat session from Cisco UC Integration for
Microsoft Lync.

Procedure

Step 1 Right-click a contact in Cisco UC Integration for Microsoft Lync in either search results, the Call History tab,
or the Voicemail tab.

Step 2 Select Chat.
This feature is only available with Microsoft Lync
2010.

Note

This feature will not work if Microsoft Lync is not running or the user is not signed
in.

Note
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C H A P T E R  3
Virtualization Experience Client Media Engine

• Cisco Unified Communications and the Virtual Environment, page 15

• Device Management, page 16

• Audio, page 17

• Video Resolution, page 19

• Screen Lock Call Control, page 19

Cisco Unified Communications and the Virtual Environment
In a virtual environment, your Cisco Unified Communications application (such as Cisco Jabber or Cisco UC
Integration for Microsoft Lync) runs on your hosted virtual desktop. The hosted virtual desktop is a form of
desktop computing. Your hosted virtual desktop looks and functions like a regular desktop; however, your
Windows desktop, other software, and your data reside in a central location called a data center. You access
your hosted virtual desktop over a secure Citrix or VMware connection.

The hosted virtual desktop removes the need for typically more costly physical desktop PCs. Central hosting
in the data center reduces the cost of providing the applications and computing services that you need. This
type of setup is commonly referred to as a virtual environment.

In a virtual environment, Cisco Virtualization ExperienceMedia Engine is required to support audio and video
calls with your Cisco Unified Communications application. Cisco Virtualization Experience Media Engine
also provides support for the following accessories:

• Logitech UC Keyboard K725-C

• Logitech Mouse M525-C

• Logitech Webcam C920-C

• Jabra Handset 450 Cisco

• Jabra Speak 450 Cisco
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If you use supported accessories other than those that are designed for Cisco, the function of these devices
may be different from the function of the devices that are described in this document.

Note

For a complete listing of supported audio and video accessories, see Unified Communications Endpoint and
Client Accessories at http://www.cisco.com/en/US/prod/voicesw/uc_endpoints_accessories.html.

For information about Cisco Virtualization Experience Client and the designed for Cisco Accessories, see
User Guide for Cisco Virtualization Experience Client 6215.

Device Management
Device management in a virtual environment differs from a local installation. Cisco Virtualization Experience
Media Engine (VXME) includes a component called Device Selector. Device Selector is a menu that you use
to manage your cameras and audio devices. You can view your currently active cameras and audio devices
or change them. A list of audio devices appears first in the menu, followed by a list of cameras. The list of
audio devices includes the thin client built-in audio device. Your active camera and audio device selections
apply to all applications.

The icon for the Device Selector ( ) appears in the notification area, in the bottom right corner of the screen.
Some icons, including the Device Selector, can be hidden. Click the up arrow in the notification area to show
hidden icons.

View Your Active Camera or Audio Device
You can check to see which of your cameras or audio devices is currently selected.

Procedure

In the Windows notification area, click .
Check marks indicate the selected devices.

Change Your Active Camera or Audio Device
Use the Device Selector menu to select a different active camera or audio device. You must have multiple
devices connected.

Procedure

Step 1
In the Windows notification area, click .
Check marks indicate the selected devices.

Step 2 Click a device (camera or audio) to make it active.
Step 3 Click anywhere except on the Device Selector menu to close the menu.
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Audio
All audio from your Cisco Virtualization Experience Client and your hosted virtual desktop plays through
your selected audio device. You can adjust the volume on the Cisco Virtualization Experience Client; however,
each time you log in to your hosted virtual desktop, the volume setting synchronizes with the setting on your
hosted virtual desktop.

Default Audio Device Selection
When you start your Cisco Virtualization Experience Client for the first time, the default audio device is the
first device in the following order:

1 Hands-free—If multiple hands-free devices are connected, the default is the first device in alphabetical
order.

2 Headset—If multiple headsets are connected, the default is the first headset in alphabetical order.

3 Handset—If multiple handsets are connected, the default is the first handset in alphabetical order.

4 No devices connected—The default audio device is the Cisco Virtualization Experience Client built-in
speaker.

The next time that you start your Cisco Virtualization Experience Client the default audio device is the last
selected active device, provided that the device is still connected. Otherwise, Device Selector makes the first
available device active (subject to the preceding order of selection.)

After you connect a new device, a “New device found” message appears in the notification area and the new
device becomes the active device.

When you disconnect a device, a “Device disconnected message” appears in the notification area and the next
device in the Device Selector list becomes active.

Ringtone
When you have an incoming call, an incoming call notification appears on your screen and your active audio
device plays the ringtone. Depending on your active device, the Cisco Virtualization Experience Client built-in
speaker also plays the ringtone to ensure that you can hear it. If the hands-free speakerphone is the active
device, the ringtone plays on the speakerphone. If the hands-free speakerphone is not the active device, or it
is not connected, both the active device and the Cisco Virtualization Experience Client built-in speaker play
the ringtone.

With some wireless headsets, you may not hear the ringtone. Some headsets play their own internal tone.Note
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Device Ready Indicator
If you perform one of the following off hook actions and you have no incoming or in-progress calls, the active
device plays a beep tone to indicate that the device is ready. The device becomes the active device if it was
not already.

• Press the Call key on the Logitech UC Keyboard. If the headset is the active device, the beep plays on
the Cisco Virtualization Experience Client built-in speaker.

• Press the Call key on a headset.

• Press the Speaker button on the Jabra Speak 450.

• Lift the Jabra Handset 450 from its cradle.

For example, if your current active device is your headset and you lift the handset from the cradle, the handset
becomes the active device and plays the beep tone to indicate that it is ready. The UC Keyboard indicates
your new selection.

You must be signed in to Cisco Jabber or Cisco UC Integration™ for Microsoft Lync.Note

Adjust Cisco Unified Communications Volume
You can adjust the volume settings for certain applications on your hosted virtual desktop, including Cisco
Jabber or Cisco UC Integration™ for Microsoft Lync.

You can adjust the Cisco Unified Communication volume during a call by using the volume control on
the call strip, in the active call window.

Note

Procedure

Step 1 In the notification area, click the Speaker icon.
Step 2 ClickMixer.
Step 3 Use the slider for Cisco Jabber or Cisco UC Integration™ for Microsoft Lync to increase or decrease the

volume.

Adjust Settings for Jabra Bluetooth Devices

Before You Begin

Jabra PC Suite must be installed.

   User Guide for Cisco UC Integration for Microsoft Lync and Cisco Virtualization Experience Media Engine for
SUSE Linux Release 9.7

18

Virtualization Experience Client Media Engine
Device Ready Indicator



Procedure

Step 1 Open the Jabra Control Center.
Step 2 Click the Jabra device for which you want to modify the settings.
Step 3 Click Softphone (PC).

Step 4 Check the Open phone line on undock check box.
Step 5 Under PC audio control, click Automatic.

Step 6 From the Softphone Vendor list, select Other.

Step 7 Click Apply.

Video Resolution
The only supported camera that features hardware encoding is the Logitech WebCam C920-C.

You must use this model camera with Cisco Jabber or Cisco UC Integration™ for Microsoft Lync and Cisco
Virtualization Experience Media Engine to support video resolutions up to 720p (720 horizontal lines and an
aspect ratio of 16:9) at 30 frames per second in the virtual environment. Other supported cameras only support
video resolution up to 360p.

Numerous other variables, such as network traffic or far-endpoint video capability, can affect video quality.

Do not switch from a high definition (HD) camera with hardware encoding to a standard definition (SD)
camera during a call. Video calls use the settings that are established at the start of the call. The higher
setting for the HD camera causes video performance issues with an SD camera. If you want to switch to
an SD camera, do so between calls.

Note

Screen Lock Call Control
While your hosted virtual desktop is in screen lock, you cannot make calls, but you can receive them. If you
have an incoming call while your hosted virtual desktop is in screen lock, you can use one of your accessories
to answer the call. With supported accessories, the following call control features are available during screen
lock:

• Answer call

• End call

• Hold call

• Resume call

• Change active device (Logitech UC Keyboard feature)

• Toggle audio mute
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• Toggle video start and stop (Logitech UC Keyboard feature)

• Adjust audio volume
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